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0. Preliminaries

0.1 This is open source software

Hershey Text is open source software, that we are making available without war-
ranty, in the hopes that it will be useful. Hershey Text is licensed under the GPL 
v2.

Feedback is sincerely appreciated. You may come across things that don’t work 
as expected. Sometimes, this may be due to a known bug in the software — per-
haps one fixed in a more recent version — or, it may be that you’ve come across 
something new, or a problem in the documentation. Please don’t hesitate to let 
us know about it! 

0.2 Links

Current links to software and the latest version of this user guide can be found at: 
 https://wiki.evilmadscientist.com/hershey

The preferred method of feedback is to post an issue at our repository:
 https://gitlab.com/oskay/hershey-text

General documentation for products from Evil Mad Scientist can be found at:
 https://wiki.evilmadscientist.com/

Please refer to the front cover of the guide to find the date and applicable soft-
ware version of this document.

0.3 Copyright notice:
Software and manual:  © 2019 Windell H. Oskay, Evil Mad Science LLC

https://wiki.evilmadscientist.com/hershey
https://gitlab.com/oskay/hershey-text
https://wiki.evilmadscientist.com/
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1. Introduction to Hershey Text
Hershey Text is an Inkscape extension designed to replace text in your document 
with stroke fonts rendered into paths. This tool can assist with text creation for 
use with pen plotters, lasers, engraving tools, routers, CNC mills, and other sim-
ilar digital fabrication tools.

Hershey Text v 3.0 performs font substitution on your document, taking your 
page of mixed text — in paragraphs or however laid out — and replacing those 
text elements with single-stroke text, using specially designed purpose-built 
fonts. 

In this documentation we will primarily refer to the use case of using Hershey 
Text to prepare text for use with a pen plotter, but it is equally applicable to cre-
ating text for use with other types of digital fabrication tools.

1.1 Credits and acknowledgments
This software is written and maintained by Evil Mad Scientist, designer and man-
ufacturer of pen plotters and writing machines such as the AxiDraw, EggBot, and 
WaterColorBot, to provide a useful tool to assist with certain workflows. 

Fonts included with this distribution include original Hershey fonts and fonts li-
censed under the SIL open font license. Sheldon B. Michaels and Marty McGuire 
contributed to the creation of these font files from the original source materials.  
For additional credits and links, please see the individual font files and/or visit 
https://wiki.evilmadscientist.com/hershey

2. Outline Fonts and Stroke Fonts
Before delving into the specifics of Hershey Text, we will first cover some import-
ant background material about the structure of fonts, and important consider-
ations when working with text on plotter-like tools. 

https://shop.evilmadscientist.com
https://wiki.evilmadscientist.com/hershey
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2.1 Outline Fonts
All standard computer fonts — those found in formats including TrueType, Post-
Script, and OpenType — are outline fonts. In outline fonts, each character in the 
font file describes a vector outline shape, which will be filled in by tiny pixels when 
displayed on your screen or rendered by an inkjet or laser printer. 

Things are different when you wish to use a pen plotter or any other machine that 
moves a tool along a path, since it follows paths rather than drawing pixels. 

Suppose that you start with some text in Inkscape, and then convert it into paths 
using the Path > Object to Path menu command.  When you do so, the machine 
will be able to follow the vector shapes generated from the data in the font file.

Below is a sample of text written in a common handwriting-like font:

The upper part of the sample shows the text filled in, as it will typically appear on 
your screen, or when printed on a laser printer. The lower part shows the outline: 
The actual vector shapes contained within the font file, and how the output will 
look when printed with a pen plotter.

If you had picked that handwriting-like font with the intent of creating handwrit-
ing-like output on a plotter, this is probably not what you had intended.

The cause of this perhaps unexpected behavior is that one could easily, though 
mistakenly, assume that a handwriting-like font contains handwriting-like strokes. 
For example, the letters “t” and “x” both look like they could be made up of two 
strokes that overlap, and the “O” looks like it could consist of a single loop. How-
ever, in order for outline fonts to render correctly on your screen, the “t” and “x” 
are instead composed of a single complex shape, while the “O” consists of two 
concentric loops.

To be quite explicit: there is absolutely no data contained within an outline font 
that represents or corresponds to the visual centerline of the characters. This 
fact is consistent with all standard computer fonts, and will present no unexpect-
ed behavior, so long as you are aware of it. 

Outline Font Example
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While it is straightforward to understand where font outlines come from, they 
can still potentially present several disadvantages:

(A) Visible outlined appearance
As we have already noted, if you plan to use fonts for handwriting-like applica-
tions, outlines can be problematic. Fonts tend to look more like computer fonts 
and less like handwriting when you can see the outlines.

(B) Excess apparent width of text
When working with fabrication tools that have a nonzero width — whether that is 
a pen tip, laser beam, or a milling cutter — tracing that tool around the outline of 
text rather than through its center can increase the apparent width of the text.

Here is what it looks like when you apply the same (nonzero) stroke width to text 
made up of center lines versus made up of outlines:
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When cutting with a CNC mill, the width of your milling cutter provides 
a real limitation — using outline fonts, you would need to use a smaller 
cutting tool (typically requiring a lower cutting speed) to fit legible text in 
the same area. However, cutting along the center line can be smaller and 

more efficient:

In some other applications, such as when engraving with a laser or cutting 

with a waterjet, the cutting width is relatively thin, which can allow you to 
use very small text, so long as it isn’t outlined:

(C) Excess path length and time
Finally, the perimeter around the outline of text is much longer — at least twice 
the total length of the center lines drawn through text.  For example, every “O” 
is two loops, not one.

This means that your pen plotter or CNC tool will take typically twice as long to 
write out the text. That represents not just time, but also more ink usage (with a 
pen) or wear on your cutting tool or laser.
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2.2 Stroke fonts
The ideal type of font to use with a plotter or cutting tool is a stroke font, also 
known as an engraving font. That’s a font where each visible character is defined 
by strokes of non-zero width, rather than by the area enclosed by a path. 

The following sample of text is rendered with a stroke font. In the lower line,we 
have colored the individual paths within each character so that you can tell them 
apart:

As you can see, characters like the “t” and “x” are here composed of two inter-
secting strokes. Similarly, a letter “o” in this font consists of a single loop. This 
particular stroke font is a single-stroke font, since each visible line is made up of 
only a single path. (Some other stroke fonts instead use multiple strokes to con-
struct wider characters, e.g., bold fonts.) 

Stroke fonts like these have “efficient” paths without redundant loops, which 
makes them ideal for use with computer-controlled tools. They are also well-suit-
ed for handwriting-like applications, because the characteristics of the fonts 
more closely mimic how humans write. However, since they are not regular com-
puter fonts, it is generally not possible to use them as one would other fonts — 
for example within word processors or graphics applications.
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3. Hershey Text version 3.0
Hershey Text is a helper application, built as an Inkscape extension, that performs 
single-stroke font substitution. It takes your document that contains text ele-
ments — in paragraphs or however laid out — and replaces those text elements 
with stroke-based text, using specially designed fonts. 

While this works quite well, there are several important process limitations that 
you should be aware of from the start:

(I): This typesetting process takes editable text (that is, text that you type) 
and renders a set of vector paths (lines and curves) that the pen can follow. 
Once you have rendered that text into paths, it can no longer be edited as 
though it were text. Once the text is rendered into a set of paths, those 
paths can be edited like other paths with Inkscape’s path editing tools.

(II): Relatively few stroke based fonts are available. A number of handwrit-
ing-like styles are included with this software; you can see them listed in the 
appendix to this guide. While you can add your own stroke-based fonts, they 
do need to be in the proper format.

(III): Since Hershey Text works by a process of font substitution, you should 
expect that your text layouts will change slightly in terms of spacing and how 
lines of text wrap, just like you would any other time that you change fonts. 

3.1 Name and history
This software is named after Dr. Allen Vincent Hershey, who designed a set of 
stroke fonts for plotters in the late 1960s. The “Hershey” fonts included with this 
software are derivatives of his original designs. 

Hershey Text v 3.0 is a successor, written from scratch, to the original version of 
Hershey Text, which we introduced in 2011: 
 https://evilmadscientist.com/go/hershey

https://evilmadscientist.com/go/hershey
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3.2 Getting Started
You can find Hershey Text in your Inkscape menu at:  
 Extensions > Text > Hershey Text

To use Hershey Text, start with a document that contains text objects. Select
the Render tab, and choose a font face from the drop-down list.

When you click Apply, it will render all text elements on your page with the se-
lected stroke-based typeface. If you would like to convert only certain text ele-
ments, click Apply with just those elements selected.

In addition to the drop-down list and text box for selecting the font face, there is 
also a check box, Preserve original text. If that option is checked, then the origi-
nal (editable) text will be left in place when the stroke-based is rendered. 

You can use the Live preview option to preview how your text will be rendered, 
before you click Apply to actually perform the rendering.
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3.3 Utility modes: Font table and glyph table
Under the Utilities tab of Hershey Text are two utility modes, that you can select 
between with a drop-down list: 

If you click Apply with the Utilities tab selected, then one of these two actions, 
to generate a table of available fonts or a table of all glyphs within a given font, 
will be executed.

The first option, Generate font table will generate and render a list of all available 
SVG fonts, previewed with sample text that you enter in the Text entry box. All 
available fonts will be listed. You can add custom fonts following the methods 
described in §3.5 Adding custom fonts on page 12. 

The second option, Generate glyph table in selected font will create a list of all 
characters (glyphs) in the selected font. The selected font, for this purpose, is the 
currently active default font, as selected on the Render tab.  This may be one of 
the included SVG fonts or the name of a custom font, if “Other” is selected from 
the drop-down list.
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3.4 About SVG fonts
Hershey Text uses fonts in the SVG font format. While this is a rather uncommon 
font format, it is perhaps the only modern font format that does support stroke-
based characters.

It is important to note that while the SVG font format does support stroke-based 
characters, not every SVG font is a stroke-based font. (Indeed, most SVG fonts 
are outline fonts.) Hershey Text does not convert outline fonts into stroke fonts, 
nor does it convert other fonts into SVG format. Its function is to replace the text 
in your document with paths from the selected SVG font.

Several stroke-based SVG fonts are included with this distribution, including both  
single-stroke and multi-stroke fonts. These SVG fonts are included within the  
“svg_fonts” directory within your Inkscape extensions directory.

3.5 Adding custom fonts
SVG fonts may be added to the “svg_fonts” directory, which is located within 
your Inkscape extensions directory. If you add an SVG font to this directory, it will 
automatically be available when generating a table of available fonts. However, 
please note that it will not show up in the drop-down list of font choices. 

To use a font that you have added to the svg_fonts directory, select the last item 
from the drop-down list, “Other (given below)”. Then, enter the name of the font 
in the “Name/Path” text box. The font name that you enter needs to exactly 
match the name of the font file (with or without the “.svg” extension).

Example: If you have a font file named “robin_handwriting.svg”, you can add it to 
the svg_fonts directory, select “Other” from the drop-down list, and enter either 
“robin_handwriting” or “robin_handwriting.svg” in the “Name/Path” text box.

Custom SVG fonts may also be located elsewhere on your computer. To use one 
or more fonts in a different directory, enter either the full path to your SVG font 
or to a directory (folder) containing one or more SVG fonts. If you give the path 
to a directory, all SVG font files within that directory will be available to Hershey 
Text. If the path is to a file, that file and all other SVG font files within the same 
directory will be available within Hershey Text. 
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Example (Mac):
A full path to a font folder or font file might look like:
  /Users/Robin/Documents/AxiDraw/fonts/       or
  /Users/Robin/Documents/AxiDraw/fonts/robin_handwriting.svg

Example (Windows):
A full path to a font directory or font file might look like:
    C:\Users\Robin\Documents\AxiDraw\fonts\       or
  C:\Users\Robin\Documents\AxiDraw\fonts\robin_handwriting.svg

3.6 Advanced methods for font selection
We have already discussed two methods of selecting the font to be used. For 
built-in fonts, you can select the font that you would like to use from the drop-
down list on the Render tab of Hershey Text.  And, for fonts that you have added 
yourself, either in the svg_fonts directory or with a path, you can select “Other” 
in the drop-down list and type the name of the font.

Beyond these, you can use automatic font-name substitution to pick fonts and 
even use multiple SVG fonts within the same document.

The order of preference for font selection is given by the following rules:

(1) Font name substitution: If there is an SVG font with a name that matches that 
of the font for a given piece of text, that font will be used. For example, if the 
original text is in the font “FancyScript” and there is an available font file with 
name FancyScript.svg, then FancyScript.svg will be used to render the text. The 
font file may be in the svg_fonts directory, or given by an external path.

(2) Default font substitution: If there is no SVG font available matching the name 
of the font for a given block of text, the face selected from the “Font face” 
drop-down list will be used as the default font when rendering text with Hershey 
Text. This may be one of the included SVG fonts or the name of a custom font, 
if “Other” is selected from the drop-down list. An internal default font selection 
will be used if “Other” is selected but no alternate font is named.

(3) External files take priority. If there are multiple font-name matches, external 
fonts given by a path take precedence over those in the svg_fonts directory. 

These methods can be used to render different text elements with different SVG 
font faces, even within the same document. You can even rename a font — either 
your own font or one of the bundled ones -- to match the name of a font that 
you’re using. For example, if example, if you rename a handwriting-like font to 
“Helvetica.svg”,  then all text in Helvetica will be replaced with that font.
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3.7 Limitations due to font substitution
Since Hershey Text works by a process of font substitution, the same types of 
changes that happen when changing fonts in other contexts may occur here as 
well. Text spanning a single line will generally stay that way, whereas text flowed 
in a box (that may span multiple lines) will be re-flowed from scratch. Style infor-
mation such as text size and line spacing can be lost in some cases. 
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3.8 About custom SVG fonts
While creating new fonts is outside the scope of this software, Hershey Text is 
designed to accept and make use of custom SVG fonts. You can create your own, 
convert fonts from other formats, or commission a custom font to be created 
for you.

3.8.1 SVG Font Repository
A repository for SVG fonts compatible with Hershey Text can be found at:
 https://gitlab.com/oskay/svg-fonts

3.8.2 Custom handwriting fonts
If you would like to commission a custom single-stroke font based on your hand-
writing, we recommend the services of a third party, Quantum Enterprises:
 https://www.quantumenterprises.co.uk/slf

Their stroke fonts are available in matched TrueType and SVG font pairs, making 
it easy to use the fonts by the font name substitution method.  They also produce 
high quality ready-made handwriting-like stroke fonts.

3.8.3 More about the SVG font format
Formal documentation about the SVG font format can be found at:
 https://www.w3.org/TR/SVG11/fonts.html

Stand-alone SVG fonts are relatively uncommon, but SVG fonts following this 
specification are used as part of the OpenType “OTF+SVG” font format, some-
times referred to as “color fonts.” A number of commercial font editing packages 
support SVG stroke fonts and/or OTF+SVG. Inkscape also offers limited support 
for SVG font creation.

3.8.4 Tips on font conversion
As we have noted, just because a font is in the SVG format does not mean that 
it is a stroke font. Converting an outline font to the SVG format will result in an 
outline font in the SVG format, not a stroke font. 

One other issue to watch out for is that some font creation and/or conversion 
software may “helpfully” close open contours in your fonts when saving or ex-
porting. That is to say, if the software is expecting to only work with outline fonts, 
it may regard (for example) your letter “C” consisting of a single arc to be defec-
tive since it has an open contour. You can check for the resulting stray lines by 
using the glyph table feature.

When possible, it is ideal to have two fonts to use: A regular TrueType (TTF) or 
OpenType (OTF) font –which can be installed on your computer, plus a matching  
stroke-based SVG equivalent, so that when you perform font substitution, the 
path-based text ends up in the same places and with the same appearance.

https://gitlab.com/oskay/svg-fonts
https://www.quantumenterprises.co.uk/slf
https://www.w3.org/TR/SVG11/fonts.html
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4. Appendix: Stroke font samples
The samples on this and the following page show the “EMS” and “Hershey” stroke 
font faces included with Hershey Text. The EMS series fonts are all single-stroke 
fonts. HersheySans1 and HersheyScript1 are single-stroke fonts; the other Her-
shey fonts are multiple-stroke fonts.
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www.evilmadscientist.com

shop.evilmadscientist.com

wiki.evilmadscientist.com

www.evilmadscientist.com/forums

shop.evilmadscientist.com/contact

Blog:

Store:

Docs:

Forum: 

Humans:

Hershey Text documentation home:
https://wiki.evilmadscientist.com/hershey

Hershey Text is open source software.
Source code and issue tracker available at:

https://gitlab.com/oskay/hershey-text

http://www.evilmadscientist.com
http://shop.evilmadscientist.com
http://wiki.evilmadscientist.com
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http://shop.evilmadscientist.com/contact
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